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Do you think the Finder is too slow and clumsy when navigating through your folder structure? Do you perhaps use a 
hierarchical Apple menu utility but are tired of zigging and zagging your mouse from submenu to submenu? Or 
maybe you just like color icons. If so, then you should try Greg's Browser. Displaying multiple folders in a single 
window, Greg's Browser lets you simultaneously see the contents of a folder, its parent, and a subfolder, providing a 
quick and easy way of moving both up and down through your folder hierarchy. Greg's Browser can open StuffIt™ 
and Compact Pro archives, and it uses Aladdin's “StuffIt Engine™” for stuffing, binhexing, and expanding files. Greg's
Browser also uses “Macintosh Drag and Drop” for inter-application dragging.

Greg's Browser requires System 7 and Color QuickDraw (which is built into the ROM of every Mac with a 68020 
processor or better). If you have reached this “Browser Docs” window, then your Mac meets these requirements.

Basic Usage

To select a file or folder, just click once on its name in the file lists. If you select a folder, the Browser displays its 
contents in the file list immediately to the right. If there is not space for another file list, the Browser slides all the file 
lists left to make room. You can select multiple files simultaneously by holding down the <shift> or <command> keys 
while clicking. The Browser draws a 3D border around the active file list, and at the bottom of the window it displays 
the icon, name, and various other information about the currently selected files. You can browse into StuffIt™ and 
Compact Pro archives just like they were normal folders, in which case the Browser displays the expanded and 
compressed size of the file at the bottom of the window.

Double clicking on an entry in the file lists opens the selected files or folders just like in the Finder. In particular, this 
action launches applications, opens documents with their creators, and opens folder windows within the Finder. You 
can achieve the same result with the “Open” command in the File menu, with its <command>-O keyboard equivalent, 
or with <command>-<down arrow>. If you are browsing through a StuffIt™ archive and have “StuffIt Engine™” 
version 3.5 or later, double clicking on files unstuffs them.

To move back up through the folder hierarchy, click on the title box above one of the file lists. If you click and release 
quickly, the Browser slides the file lists right by one position. If you hold the mouse down, the Browser pops up a 
menu letting you choose how far you want to move up the folder structure. When you release the mouse, the Browser
slides the file lists right repeatedly until it displays the folder you selected. From the keyboard, you can hit <esc> or 
<clear> to slide the file lists right by one position.

To change the name of the selected file, either click on the file name at the bottom of the Browser window or press 
the <return> key. Clicking anywhere else in the window or pressing the <return> or <tab> keys saves your changes to
the file name and updates the file lists accordingly. To cancel editing the file name without making any changes, press
the <esc> key. You cannot edit the names of locked files or certain critical files and folders in your system folder.

Bookmarks

The row of icons at the top of the window and the trash icon at the lower right act as “bookmarks”, letting you jump 
quickly to a file or folder that you use frequently. To add a new bookmark, drag the desired file or folder from its file list
and drop it on one of the empty spaces at the top of the window. To move a bookmark from one slot to another, just 
drag it from its former position to one of the remaining empty spaces. To remove a bookmark, drag it away from the 
top of the window so that its shadow disappears; you need not drag it to the trash. The Desktop and Trash 
bookmarks are fixed in their positions and cannot be removed.



If you click once on a bookmark, the Browser jumps to the corresponding position in the file lists. If you hold down the
<option> key while clicking an alias bookmark, the Browser resolves the alias and jumps to the position of the original
file in the file lists. If you double click a Bookmark, the Browser opens the bookmark file as if you had double clicked it
in the Finder. Note that double clicking will also jump to the bookmark position in the file lists (since to click twice, you 
must first click once). To open the bookmark file without jumping to it in the file lists, single click the bookmark while 
holding down the <command> key.

You can also drag files from the file lists and drop them on previously installed bookmarks (provided that the 
bookmark represents a folder or an application that can open the selected files). This provides a quick way of moving 
or copying files to a drop folder or opening files using your favorite drop box mini-applications, such as “File Buddy” or
any of the various Finder info editors. Pressing the <delete> key is equivalent to dragging the currently selected files 
and dropping them on the trash bookmark.

Drag and Drop

The Browser lets you drag files directly from their file lists and drop them onto folders or applications in any other file 
list (even if it is contained in a different Browser window). Whenever you can drop the files onto a folder or 
application, the Browser highlights the corresponding mini-icons as you drag over the file list entry. The rules for drag 
and drop are the same as in the Finder: Dragging moves files if the source and destination are on the same volume, 
but copies if they are on different volumes. Holding down the <option> key at the start or end of a drag forces the 
Browser to do a copy, except if you are dragging to the trash. Hey, I didn't invent these rules.

If you have System 7.5 or the “Macintosh Drag and Drop” extension, you can drag files between the Browser and 
other drag-savvy applications. In particular, the Finder in System 7 Pro (and all subsequent releases) supports the 
Drag Manager, so you can drag files directly from the Browser lists to folders or applications in the Finder and vice-
versa.

If you have Aladdin's “Expander Enhancer” (also known as the “StuffIt Engine™”), then you can drag files into a 
StuffIt™ archive to stuff them. This feature does not require “Macintosh Drag and Drop”. However, if you do have 
“Macintosh Drag and Drop”, then you can also drag files out of a StuffIt™ archive to unstuff them. Whenever you drag
to or from an archive, the Browser does not delete the original files. Please note that you can NOT remove files from 
an archive by dragging them to the trash; the Engine does not support removing files from an archive, and you will 
need to use the StuffIt™ application instead. If you are using a 3.0.x version of the Engine, you should upgrade to 
version 3.5, which is included with the shareware “DropStuff with Expander Enhancer™” and several other Aladdin 
products. There are several bugs in version 3.0.x, and the Browser limits your drags to and from Stuffit™ archives 
accordingly.

File Menu

The New Folder command creates a new folder titled “untitled folder” in the active file list of the frontmost Browser 
window and immediately lets you edit its file name. You can create a new folder inside a StuffIt™ archive if you have 
“StuffIt Engine™” version 3.5 or later, in which case the Browser prompts you for the name of the new folder before 
creating it. If you hold down the <option> key, the Browser changes New Folder to New Archive, and if you select this 
command, the Browser creates an empty StuffIt™ archive. This does not require the StuffIt Engine, although you 
cannot do very much with an empty archive without it.

The Close Window command closes the frontmost Browser window as if you had clicked in the close box. If you 
attempt to close the last Browser window, the Browser hides it and switches to the Finder instead. The window 
reappears when you switch back to the Browser.

The Open, Print, Get Info, Sharing..., Duplicate, Make Alias, and Put Away commands all act on the current selection 
in the frontmost Browser window and behave just like in the Finder.



If you are browsing through a StuffIt archive and have “StuffIt Engine™” version 3.5 or later, the Browser changes 
Open    to UnStuff.... If you select this command or double click on files within an archive, the Browser prompts you for
a destination to which to unstuff the currently selected files.

The Reveal command swiches to the Finder, highlighting those files that are currently selected in the frontmost 
Browser window (opening up their parent folder window in the Finder if it is not already open).

If you hold down the <option> key while selecting from the File menu, the Browser changes Get Info and Reveal    to 
Get Original Info and Reveal Original. If you select one of these commands, the Browser resolves any aliases in the 
current selection before performing the corresponding action.

Edit Menu

When you are not editing a file name, the Copy command copies to the clipboard a list of all the selected files in the 
currently active file list, and the Select All command selects all the files in the currently active file list.

When you are editing a file name, the commands in the Edit menu behave like you expect them to.

The Preferences… command brings up a dialog box where you can modify the following settings:

⁄    Show Invisible Files
When this box is checked, the Browser shows files that are marked as invisible. Such files, which include desktop 
databases, custom folder icons, and the famed “AppleShare PDS”, do not appear in Finder windows. Note that in 
order to move, copy, or trash these files, you must first make them visible using the “Invisible” command in the Label 
menu.

⁄    Confirm <delete> Key
When this box is checked, the Browser puts up a caution alert whenever you hit the <delete> key to move a file or 
folder to the trash. This is in case you press <delete> by accident. Although such mistakes can easily be undone by 
dragging the file or folder out of the trash, it can be disconcerting to have your files magically disappear from their 
folder.

⁄    Show File Version Info
When this box is checked, the Browser shows the file version number (if the file has one) at the bottom of the window.
This can slow down disk access, particularly with slow media such as floppy disks or CD-ROMs.

⁄    Show Projector Status
When this box is checked, the Browser shows, via mini-icons on the right side of the file lists, whether or not project 
files have been checked out. If you do not use “Projector” or “SourceServer”, you should leave this box unchecked, 
as it slows down disk access considerably.

⁄    About Box at Startup
When this box is checked, the Brower puts up its “About...” box when it first starts up. This is as close as I get to the 
proverbial "Annoying Shareware Message". Please leave this box checked until you register to serve as a reminder.

⁄    Show Magic Menu™
When this box is checked, the Browser adds a menu to the menu bar that lets you stuff, binhex, and expand various 
file formats. It works just like the “Magic Menu™” extension in Aladdin's “StuffIt Deluxe™” package. This menu also 
lets you expand and compress StuffIt SpaceSaver™ files. Most of the features in this menu require the “StuffIt 
Engine™” and will be disabled if it is not installed.

⁄    Calculate Folder Sizes
When this box is checked, the Browser shows the sizes of folders at the bottom of the window. This feature requires 
the Thread Manager (which is built into System 7.5 and later), and it will be disabled if the Thread Manager is not 



installed.

The Font and Size pop-up menus let you choose the font and size for the file lists and bookmarks. The information at 
the bottom of the screen remains in Geneva 9. If you check the Anti-aliased (smoothed) box, the Browser uses the 
corresponding TrueType or PostScript font to smooth out the jagged edges of the font. For this option to work, you 
must have a monitor set to 16 grays or better, and your chosen font must have a TrueType or PostScript version. Anti-
aliasing takes time, so this feature is recommended only for those with fast Macs (25mHz '040 or better), and it looks 
best at high (>88 dpi) resolutions.

Label Menu

The Label menu works just like it does in the Finder. In addition, the Invisible command lets you toggle whether the 
selected files are visible or invisible. Files marked as invisible do not appear in Finder windows, but you can still see 
them in the Browser if the “Show Invisible Files” option in the “Preferences” dialog box is checked. The “Invisible” 
menu item will be disabled if the “Show Invisible Files” option is turned off.

Special Menu

The New Browser command opens up a new Browser window staggered slightly to the right and below the current 
window. This new window opens directly to the active folder shown in the current window. Multiple Browser windows 
come in handy when you want to move or copy files. You can use the first window to navigate to the files that you 
want to move and the second to navigate to their destination.

If the current selection is an alias file and you hold down the <option> key while selecting the New Browser 
command, the Browser resolves the alias file and opens a new window showing the path to the original file.

The Eject Disk, Erase Disk..., Empty Trash, Restart, and Shut Down commands work just like they do in the Finder. 
The Eject Disk and Erase Disk... commands require System 7.5 or the “Finder Scripting Extension” and will be 
disabled otherwise.

Magic Menu™

The Magic menu is modeled on the “Magic Menu™” extension in Aladdin's “StuffIt Deluxe™” and “Aladdin Desktop 
Tools™” packages, thanks to code graciously provided by Aladdin Systems, Inc. To see this menu, you must check 
the “Show Magic Menu™” box in the “Preferences...” dialog. Most of the options in this menu require the “StuffIt 
Engine™” and will be disabled if it is not installed.

The Expand command expands StuffIt™ (.sit), Compact Pro (.cpt), AppleLink (.pkg), ZIP (.zip), ARC (.arc), gzip (.gz), 
and Unix Compress (.Z) files. It also decodes BinHex (.hqx) and UUEncoded (.uu) files, as well as expanding StuffIt 
SpaceSaver™ files. Don't thank me for this little miracle—thank Aladdin.

The Stuff command compresses the selected files into a new StuffIt™ archive (.sea).

The Make Self-Extracting command compresses the selected files into a self-extracting StuffIt ™archive (.sea). If the 
selected file is already a StuffIt™ archive, this command adds the self-extracting code and changes the name to end 
in “.sea”.

The BinHex Encode command encodes the selected files into the BinHex (.hqx) text format commonly used on the 
internet.



The SpaceSaver Compress command compresses the selected files using the StuffIt SpaceSaver™ transparent 
compression format. This option is disabled if StuffIt SpaceSaver™ is not installed.

The View... command lets you inspect the contents of the selected files using the Viewer Engine™ from Aladdin 
Desktop Tools™. This option is disabled if ADT is not installed.

Other Neat Stuff

If you resize the window to be wide enough (almost but not quite the full width of a standard 13" or 14" screen), the 
Browser will switch from three file lists to four and from six bookmarks to eight. It will also use some of the extra 
space at the bottom of the window to show the creation and modification dates for the currently selected files.

If you click the Zoom Box at the right end of the Browser window's title bar, the Browser window collapses.    Clicking 
the Zoom Box again returns it to its normal size.

For those of us without extended keyboards, the Browser uses the numeric keypad to simulate the scrolling keys 
“Home”, “End”, “Page Up”, and “Page Down”. I'll leave it up to you to figure out which numbers do what.

If you drag a file or folder and drop it on the Browser application, the Browser opens a new window to that file or 
folder.

Shareware Info

Greg's Browser is shareware; it is NOT free. If you use it for more than two weeks, you should pay a $20 registration 
fee. I understand if you are an impoverished student or have trouble dealing with your company's bureaucracy, and if 
that is the case, then just try your best. From my previous experiences, I estimate that about 1 in 20 people registers 
the shareware that (s)he uses regularly, perhaps much less, so if you have ever wanted to rise above the rest of 
humanity, here is your chance!

Kagi
You can pay by credit card, check, or cash in various currencies. Registrations are handled by Kagi, a 
payment processing service. To register, use the enclosed “Register” application to create a 
customized form, which you then mail or e-mail to Kagi, whose address is given on the form (if you 
cannot find Kagi's address, then you are doing something wrong).

Alternatively, you can register via credit card over the web using the Kagi Online Order Processing 
service. The URL is <http://order.kagi.com/?GL&S> (or <http://order.kagi.com/?GL> if your browser 
cannot handle secure transactions).

Contacting the Author
Please note that Kagi is only a registration service, NOT a software publisher. Their addresses are for sending 
payment only. If you have questions or comments about Greg's Browser, you should contact me directly by internet e-
mail at <greg@math.harvard.edu>. Please do NOT send shareware payments directly to me. All shareware 
payments should be sent to Kagi Shareware as per the instructions on the registration form.

After Registering
THERE ARE NO PASSWORDS, SECRET CODES, OR REGISTRATION NUMBERS. Once you have registered, you
are entitled to feel good about yourself and uncheck the “Show About Box at Startup” box in the “Preferences” dialog. 
Once Kagi processes your payment, which takes up to a week from when they receive it, they e-mail 
you a message with subject “Thanks for your payment” as a receipt. (If you do not have an e-mail 
address, you should check the “Postcard Receipt” box.) If you do not receive this message, contact 



Kagi at <admin@kagi.com>. 

Although some shareware authors send a floppy disk with the latest version to registered users, please note that I do 
NOT. Sorry to sound so mean, but I am a graduate student in mathematics, not a software publisher. Although it 
might not seem like a big deal to copy and mail a disk, it becomes a pain to have to do so for several people every 
day, particularly when I am preparing for exams or writing a thesis. Also, the time I spend trying to run a business 
detracts from the time I spend programming. Whenver I release a new version, I make sure that it is available on the 
internet archives and online services. With time, new versions propagate to BBSs, user groups, and some periodic 
CD-ROMs as well. If you do not have access to such sources and your version is sufficiently out-of-date, you can 
send me a polite letter (to the Princeton address) requesting an update.

Although I have raised the price from previous versions, those of you who have already registered do NOT need to 
send me any additional payment (just pat yourself on the back for making a good investment). If you have not yet 
registered but think that this version is overpriced, please let me know how I can improve it to make it worth the fee.

Please note that although I plan to release new versions with significant enhancements and will attempt to fix 
problems that are brought to my attention, there is no guarantee that I will continue to support this product indefinitely.
You should register because you think the copy currently sitting on your hard drive is worth the money, not in the 
expectation that I will fix the bug that is annoying you. If you have a complaint about this version, or worry that it might
not support System 8.2 with QuickStep, AppleSeed, PowerLunch, and FastTalk, please do not register until I have 
addressed your concerns. In the interim, you can always drop me a note telling me what those concerns are and 
letting me know that you care.

Legal Bits

This software may be distributed via the internet archives, online services such as CompuServe, America Online, 
eWorld, or AppleLink, user groups, BBSs, and informal transfers between friends. Any other means of distribution, 
such as including it on a CD-ROM, bundling it with a book or magazine, or selling it in a commercial shareware/public
domain software collection, requires the written consent of the author. Whenever this software is distributed, it must 
be distributed unaltered and as a complete package, including the Register program. Charges for distributing this 
software must not exceed a reasonable downloading cost or the price of the medium on which it is distributed.

Use this software, Greg's Browser, at your own risk. The author, Gregory D. Landweber, makes no 
claims as to the fitness of this software for any particular purpose other than taking up a couple 
hundred K on your hard disk. The author's liability in case of damages caused by use or misuse of this 
software is limited to one tall glass of freshly pressed melon nectar, or the cash equivalent thereof. 
Don't sue!
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